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Diels-Alder Reactions

About this Lesson:

In this lesson plan, students will examine the relationship between a diene and a dienophile in a
Diels-Alder reaction. Transition state theory will be introduced to analyze the concerted
mechanism of a [4+2] cycloaddition. Reaction energy diagrams will be investigated to determine
whether a reaction is exergonic or endergonic.

Using Maestro, students will use Jaguar's AutoTS panel to calculate the energetics of the reactants,
product, and transition state. Students will also calculate the HOMO and LUMO of reactants to
help with visualizing Tt molecular orbital overlap.

Learning Objectives:

e Identify transition state structures of Diels-Alder reaction mechanisms

e Plot reaction energy diagrams with activation energy barriers to determine their
chemical reactivity characteristics (i.e. endergonic, exergonic, etc.)

e Generate molecular orbitals of the diene and dienophile to analyze favorable orbital
overlap for product formation

Lesson Contents:

—_

Setting Up the Maestro Session
Introduction to Diels-Alder Reactions
Generating Molecular Orbitals
Locating Transition States with AutoTS
Individual Exercise

Summary, Additional Resources, and References
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Glossary of Terms
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Standards Alignment: Assessments for Understanding:
e |B Diploma Programme: The following types of formative assessments are
o What drives chemical embedded in this lesson:

'rea.ct|ons (Reactivity 1) e Assessment of student understanding
e ACS Guidelines . . >
through discussion of warm-up questions
o Substitution mechanisms and filling in any knowledge gaps about
(Conceptual Topics) substituent effects of Diels-Alder reactions
o AAMC MCAT
o Structure, function, and
reactivity of
biologically-relevant
molecules (5D)

e Visual assessment of student-generated
transition state structures, reaction energy
diagrams of Diels-Alder reactions, and
molecular orbitals of the reactants

Associated Documentation Pages: AutoTS panel, Jaguar Geometry Optimization: The

Basics
Warm-Up Questions:

Watch the Khan Academy videos on the Diels-Alder reaction.

1) Label the following substituents as either electron-withdrawing or
electron-donating:

a) -COOH
b) -Me
c) -OH
d) -NO,

1) To speed up a Diels-Alder reaction, what types of substituents should be placed on
the diene and dienophile?

Need help? Contact us at teaching@schrodinger.com
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1. Setting Up the Maestro Session

At the start of the Maestro session, it is essential to 1) check your mouse actions, 2) change

the file path to the Working Directory for this lesson, and 3) save your project file. The

working directory indicated in this section contains the files necessary to complete this

lesson. If you do not set the appropriate working directory, you will be unable to run any

calculations.

[@ Schrodinger

VIRTUAL
WORKSTATION

Password

By clicking Login, you agree to use the Schrédinger
Virtual Cluster in accordance with
the Schrodinger End User License Agreement.

Figure 1-1. Virtual workstation login page.

-

Figure 1-2. Course-data folder on the desktop.

1. Launch the Virtual Cluster

2. Double-click the course-data folder
on the desktop

@ Schrodinger Education

The recipient shall not use the Schrédinger software, materials and information other than for the purposes for which they were distributed. Schrédinger owns the software and all materials, and retains all related

intellectual property rights. Schrédinger will retain all intellectual property rights relating to any suggestions, ideas, enhancement requests, feedback, recommendations or other information provided by the
recipient or any third party. The recipient shall not use Schrédinger’s names or marks without Schrédinger’s prior written consent. THE SOFTWARE AND MATERIALS ARE PROVIDED "AS IS" WITHOUT WARRANTY OF
ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL SCHRODINGER OR ITS AFFILIATES OR LICENSORS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL,

PUNITIVE OR EXEMPLARY DAMAGES.



Back to Lesson Contents

Een 3. Right-click the Diels_Alder folder

| openinNew Tab and select Copy to > Desktop
Open in New Window

Open With Other Application...
ge Cut
[ Copy

Make Link

> other pane
» 5] Home Folder

(o) Desktop

Figure 1-3. Copy the lesson folder to the
Desktop.

& Move to Trash

4. Double-click the Maestro icon on
the desktop

] ] Customize Mouse Actions
‘Customize actions for: uttons and scrol eel .,‘
No Modifiers Shift Cmd Shift+Cmd 5 C h k t‘
— . €CK your mouse actions.
Button 2 Rotate (& spot center) X or Y rotate (gesture-based) Z rotate Zoom
Button 3 Translate X or Y translate (gesture-.  Z translate G t W k
B e} o (o OrKspace >
Button 263 Zo0m H M A t'
e Customize Mouse Actions
Swap buttons: 1&2 183 2&3 Reset Defaults

o Note: This lesson was made

with a three-button mouse
with a scroll wheel, but a
trackpad can still be used
o Trackpad keys:
=  Up/Down trackpad =
Zoom In/Out

Figure 1-4. Change the mouse actions.

m Option = Rotate
m Control = Translate
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FIE] Edit Select Workspace Scripts View Window
New Project... Ctrl+N

6. Go to File > Change Working

Open Project... Ctrl+0 Directory

Open Recent Project »
Save Project As... Ctrl+Shift+5
Close Project Ctri+w

Import Structures... Ctri+l

Import Recent Structures 4
Import From .
Merge Project...

Get PDB...

Export Structures...

Export to LiveDesign...

Change Working Directory...

Back Up Project...

Restore From Backup...

Save Checkpoint

Quit Ctrl+Q

Figure 1-5. Change Working Directory option.

@ Change Directory X
Look in: /home/user975/Desktop v |& 2EE 7 . N aVIgate to Des kto p >
A Carbohydrates

HomeDlirectory course-data Diel. S_AL der folder and C“Ck

course-data (copy)
\‘ diels-alder.prj Choose

\.j

Working Directory

Pre-generated input and results files are
included for running jobs or examining

Directory:  |Diels-Alder output
Files of type: | Directories - Cancel

Figure 1-6. Change Working Directory panel.
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Edit Select Workspace Scripts View Window

New Project...
Open Project...

Open Recent Project

Ctrl+N
Ctrl+0

Save Project As...

Ctrl+Shift+S

Close Project

Import Structures...

Ctri+w

Ctrl+I

Merge Project...

Get PDB...

Export Structures...

Export to LiveDesign...

Change Working Directory...

Back Up Project...

Restore From Backup...

Save Checkpoint

Quit Ctrl+Q

Figure 1-7. Save Project option.

Import Recent Structures b

Import From »

 save Project x|
Look in: /home/user975/Desktop/Diels-Alder v |& SEE
A
L]
Home Directory
\‘
Custom Directory
&
Working Directory
Save as: | Maestro project v v Open now Help
File name:  [Diels_alder lesson| | |_save |
Files of type: | Maestro Projects (*.prj) - Cancel

Figure 1-8. Save Project panel.
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8. Go to File > Save Project As

9. Change the File name to
Diels_Alder_Llesson, click Save
o The project is now named
Diels_alder_lesson.prj
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2. Introduction to Diels-Alder Reactions

The Diels-Alder reaction is a [4+2] cycloaddition that is part of a family of reactions called
pericyclic reactions. In a pericyclic reaction, the two reactants are relatively non-polar and
do not generally go through charged intermediates. A Diels-Alder reaction combines two
components: a diene (a 4 m-electron component) and a dienophile (a 2 t-electron
component). A diene is composed of two adjacent m bonds that are conjugated. A
dienophile contains at least one 1t bond. In a Diels-Alder reaction, there is a pattern where
4 carbon atoms from the diene come together with 2 carbons from the dienophile to form
a new 6-membered ring. The mechanism follows the same pattern where 3 C-C 1 bonds
are broken, 2 new C-C bonds are formed, and a new C-C 1t bond is formed.

There are two ways to draw the arrow-pushing one-step, concerted mechanism of the
Diels-Alder reaction: clockwise and counterclockwise. Both ways to depict the flow of
electrons are correct and each way consists of drawing a total of 3 arrows. See Figure 1
below for details:

L1\ 1 1
207 6 2 6 é‘ /A-\e
+ |l - + |
Q__\‘_/ 5 3 5 N 5
4 i Ne A
Figure 1. Concerted arrow-pushing mechanism for a Diels-Alder reaction
In a Diels-Alder reaction, the diene must be conjugated and in an s-cis conformation as
shown above in Figure 1. Furthermore, substituents on either the diene or the dienophile
do not affect the bond-forming and bond-breaking pattern in the reaction. Adding
substituents to the reactants does however affect the reaction rate. It also affects the
stereochemistry of the product which you can learn more about here. The rate of reaction
is increased by electron-donating groups on the diene and electron-withdrawing groups on
the dienophile.
For the scope of this lesson, it will only focus on normal electron demand Diels-Alder
reactions, with an electron-rich diene and an electron-poor dienophile. However, there are

examples of Diels-Alder reactions that proceed with electron-poor dienes and electron-rich
dienophiles. Read more about inverse-electron demand Diels-Alder reactions here.
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Practice #1. Predict the product and arrow-pushing mechanism of
10 the following Diels-Alder reaction.

~ Heat
+

3. Generating Molecular Orbitals

Here we will show how the Diels-Alder reaction results form the constructive orbital overlap
between the highest occupied molecular orbital (HOMO) of the diene with the lowest
unoccupied molecular orbital (LUMO) of the dienophile. Since Diels-Alder reactions are
concerted, multiple bonds are formed and broken at the same time, which means that two
orbital interactions have to be considered. In order for the reaction to occur in a single
step, there must be constructive overlap between each of the lobes where the bonds are
being formed. If the phases are opposite, there is destructive interference between the
orbitals which means there is zero electron density between the atoms. Visualizing the
interactions between molecular orbitals is often difficult to see on paper, so we will
calculate and generate molecular orbitals of the Diels-Alder reaction between butadiene
and ethylene using Maestro's Jaguar.

Computational Exercise: Calculating Molecular Orbitals in Maestro

This exercise involves 3 parts:
Part 1: Build the molecules using 2D sketcher
Part 2: Run a Jaguar optimization job and calculate molecular orbitals
Part 3: Visualize the HOMO of the diene and LUMO of the dienophile
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Select Workspace Scripts View Window

Copy Ctrl+C

Copy As
Paste Ctrl+v
Paste Special

Delete Atoms Del

Figure 3-1. Open 2D Sketcher.

@ 2D Sketcher

&

cC H N

o P s

F cl si \J

A, S ~ @ Entry Title X

H: 5% 4~ Input Entry Title
e —

any ok || Cancel

NN

o000

000G

oA

R+ Py =

Editing project entry: (no entry)

[Save as New...

Figure 3-2. Drawing and saving butadiene.

Help
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Part 1. Build reactants using 2D sketcher

Let's draw the structure of the reactants
using the 2D sketcher.

1. Go to Edit > 2D Sketcher

2. Draw butadiene exactly how it is
shown in Figure 2-2.
o Go to the selection bar on
the left
o Select the single carbon bond
button
o Click and drag to add a
carbon single bond. Continue
to click and drag to draw a
4-carbon chain
o Double click the single bond
to add double bonds
o Tryto replicate the sketch
shown in the figure as closely
as possible
3. Click on Save as New and for Input
Entry Title write butadiene. Click OK.
4. Check your structure to ensure it is
in an s-cis conformation. If it is in
s-trans, go to Edit > 3D Builder
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PS— (Switch o Move Atoms mode) _ cance [NECT o Click the dropdown arrow
R e e A A T next to Move
o Select Rotate Dihedrals
o Adjust the C-C single bond
dihedral angle to 0°
o Click OK in the Rotate
Dihedral banner
5. Repeat steps 1-3 to build the

structure for ethylene

REE B -

c -G O o
NN o HY

&> Move ‘ Add -,/’I//\ Draw

Fragments

[Rotete onecrat |

Adjust Lengths or Distances

Adjust Angles or Dihedrals

Rotate Peptide Planes

Rotate Carbonyl Planes

Change Ring Conformations

Figure 3-3. Changing the dihedral angle of
s-trans butadiene to s-cis butadiene.

Part 2. Optimize the Geometry using
Quantum Mechanic DFT

Now let's optimize the molecule at the

Browse

) o _ quantum mechanical level.
Figure 3-4. Clicking the Tasks button in the

upper righthand corner. 6. With both the butadiene and
@ mrate ethylene entries selected and

\>) Jaguar
— included, go to Tasks >
ingle Point Energy... pKa... VCD Spectra...
/ Optimization... Hydrogen Bond Strength... Plot Spectra.. 0 pti m izati on us | n g J ag uar
Relaxed Coordinate Scan... Hydrogen Bond Basicity...
Rigid Coordinate Scan... Conrem— Run Input Files... o The Ja guar O pti mization
Transition State Search... Fukui Functions... Run Batch File...
panel opens
QM Conformer and Tautomer Predictor. Reaction. 7. Use Structu r_es fro m Project Ta ble

Optimize the geometry of structures by quantum-mechanical energy minimization.Opens the Jaguar panel.

- ‘ 2 selected entries
Figure 3-5. Opening the Jaguar Optimization ( )

panel.

(U Jaguar - Optimization =10 x|
Input | Theory | SCF  Optimization | Properties | Solvation = Output

Use structures from: | Workspace (2 included entries) ~

Defaults: Theory: |B3LYP-D3 = Basis set: |6-31G** =}

Figure 3-6. Setting the Jaguar Optimization
panel to optimization.
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@ Jaguar - Optimization =lolx|
”m”‘m:”“dd") I Various settings can be altered depending
octauts AN on the specific use case. We will only adjust
Figure 3-7. Setting the QM parameters for the Input tab for this example.
optimization.

8. For Theory, select B3LYP-D3
9. For Basis set, select 6-31G**

A few additional comments about preparing for an optimization calculation:

e If you hover the mouse over the basis set in the table, you can see the number of
basis functions associated with the basis set. This is useful to know since the
quality of the basis set usually improves as the number of functions increases,
noting again the trade-off between quality and computational expense

e Always make sure the charge and the spin multiplicity are correct (in this case,
biphenyl is a neutral, singlet, so charge =0 and spin multiplicity = 1). Multiplicity is
defined as 2S + 1, where S is the total orbital spin of the molecule. For instance, a
system with one unpaired electron is a doublet (multiplicity = 2), since the total
orbital spin S = %.

e Use the Atom-Level Settings button to define per-atom basis sets
e Constraints can be defined on the Optimization tab

e Properties, such as atomic charges, vibrational frequencies, surfaces and more
can be requested on the Properties tab

e Solvent can be defined via several implicit solvation models on the Solvation tab.
Note that this example is a gas-phase geometry optimization

e Read more about geometry optimization with Jaguar here
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(© Jaguar - Optimization o = 1]
Input | Theory = SCF = Optimization | Properties | Solvation = Output .
, 10. Go to the Properties Tab
Properties: (select to edit options)
Calculate Property - .
vibrationa| freguencies 11. Select Surfaces (MO, density,
Iv Surfaces (M0, density, potential) | 4 4
Atomic electrostatic potential charges (ESP) .
ATTTian popilation potential)

NBO analysis
Multipole moments

batorseabitiey i hyperpotarizability 12. Check mark Molecular orbitals

MR shielding constants

= 13. Leave HOMO-0 and LUMO+0 for this

Surfaces
Electrostatic potential onsizeadvjuslment: 0.0 Aside exerc|se' |f you Would ||ke to
Average local ionization energy Grid density: (5.0 pts/A
visualize more molecular orbitals,

Electron densities:

you may increase these values as

Sphy densit necessary
[ e o]

‘Alpha;

[%m: HOMO- ~ |0 |*|to: [LUMO+ ~ |0 || Total number of orbitals: 2 |
Beta:

From: [HOMO- ~ |0 |2/to: [LUMO+ ~ |0 |2|Total number of orbitals: 2

Figure 3-8. Selecting MO Surfaces in the
Properties Tab.

Keywords:
e 14. Change the job name to
MOs_Diels_alder
@ Jaguar - Optimization - job Settings X 15. Adjust the job settings by clicking
Output the gear button to the right of the
Incorporate: | Append new entries as a new group ~ JOb name
Job

o Choose localhost as your
Name: |[MOs Diels alder

Host: [ocanost @ ] host with 1 processor
16. Click Run

IMaximum # processors: |1 v ]l

Limit number of simultaneous subjobs (i)

oK Cancel Help
Figure 3-9. Naming and running the job.

Title| Your job + has been incorporated.
iew in F

w in Project

When the job finishes, a banner will appear
Figure 3-10. Banner that shows the job is indicating that the result has been

finished - Result has been incorporated. incorporated. At this time, the molecules
with the optimized geometries are now
shown in the workspace.

@ Schrodinger Education 13

The recipient shall not use the Schrédinger software, materials and information other than for the purposes for which they were distributed. Schrédinger owns the software and all materials, and retains all related
intellectual property rights. Schrédinger will retain all intellectual property rights relating to any suggestions, ideas, enhancement requests, feedback, recommendations or other information provided by the
recipient or any third party. The recipient shall not use Schrédinger’s names or marks without Schrédinger’s prior written consent. THE SOFTWARE AND MATERIALS ARE PROVIDED "AS IS" WITHOUT WARRANTY OF
ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL SCHRODINGER OR ITS AFFILIATES OR LICENSORS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL,
PUNITIVE OR EXEMPLARY DAMAGES.



V¥ MOs_Diels_alder._.

butadiene H
ethylene S |

Figure 3-11. The output molecules.

Figure 3-12. Toggling the surfaces on.

Figure 3-13. Toggling the surfaces off.

Invert Expand ™~ [fauto] [Lieano ]

s 2 |[mo
revious  Define... vy LR

e Selected A Quick Align  Measure  LigPrep @

"'_"7:~‘ Color Atoms
~ Element + ..tom Ligand

‘ E” Apply Labels v

& cooons & 5 surtace
°® | "®

Figure 3-14. Viewing and styling butadiene
and ethylene.
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17. A new entry group is added to the
entry list. Select and include the
molecules titled butadiene and
ethylene in this subgroup. These are
your optimized structures.

18. You can toggle on and off the
molecular orbital surfaces at the
bottom right-hand corner. Let's turn
it off for now.

19. Change the representation to
ball-and-stick by clicking on the
Style menu and choosing Apply
ball-and-stick representation
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20. To display atom labels, click Style >
Apply Labels then click the drop
down arrow on the right side

21. Click Edit Custom Labeling

22. Checkbox Element and press OK

Fo o @ caitCustom Label 23. Go back to Style > Apply Labels >

e e Custom Label and now each atom

Select fields to remove or reorder them.
Element + Atom Number Element

Stereochemistry + Charge

~=a%  Color Atoms
Element + ..tom Ligand

in your workspace should be labeled

Formal Charge

bartial Charge Note: You can toggle the atom labels on

Chirality and off by clicking Annotations label button
PDB Atom Name in the Workspace toggle on the bottom
v Custom Label rlght corner

Edit Custom Label... oK Cancel

Figure 3-15. Labeling atoms.

Figure 3-17. Toggling labels off.

V¥ MOs_Diels_alder_..
butadiene S|
ethylene S| Now that we optimized the geometry of

biphenyl, let's visualize the molecular

Part 3. Visualize the HOMO and LUMO

¥ MOs_Diels_alder._..
butadiene H orbitals.

ethylene 8 Manage..

Hide Al 24. Click the S button in the Entry List to
v HOMO the right of each entry

LUMO 25. Select either the HOMO or the
LUMO to visualize

Figure 3-18. Selecting the Surface ‘S’ button in
the Entry List
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Figure 3-19. Tile the molecules side-by-side.
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26. If you do not see any surfaces
appear onto the molecule,
remember to Toggle On the
surfaces button in the bottom
right-hand corner

27.Tile the 2 structures to visualize the
MOs of the diene and dienophile
side-by-side by selecting the +
button in the bottom right-hand
corner of the interface

28. Select the Tile by button under
Workspace Layout

o By default, moving the two
molecules will be linked. If
you wish to move only one
molecule at a time, you can
unlink their movement by
deselecting the link button

Pause & Think #1. Take screenshots of the HOMO of the diene and the LUMO of the
diene. Where does the orbital overlap occur between the two reactants?
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4. Locating Transition States with AutoTS

Next, we are going to analyze the Diels-Alder reaction between butadiene and
ethylene by determining the energetics of the reactants, transition state structure,
and products. To do this, we will be using Maestro, Schrédinger's molecular

modeling software.

Second Order Saddle Point

~ Transition
- Structure B

Minimum for .
Product A

Minimum

:"ofor Product B

Second Order
Saddle Point
Valley-Ridge
Inflection Point

Figure 3.1. General potential energy surface.

Used with permission. Created by Professor H. Bernhard Schlegel, Wayne State
University, Detroit, MI.

Locating a transition state is essential for computing the activation energy of a
reaction, and thereby the reaction rate. As a result, finding transition states is
useful in many applications: predicting reactivity, understanding reaction
mechanisms, catalyst design and optimization, predicting outcomes of various
competing reactions and more. Besides, locating a transition state is unique to
computation -- meaning the transition state cannot be ‘found’ in the lab. Read more
about Schrodinger's work in the space of Catalysis and Chemical Reactivity.
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Searching for a transition state is typically a relatively difficult task in molecular
modeling. Unlike an optimization to a minimum (see: Introduction to Geometry

Optimizations, Functionals and Basis Sets), the search for a transition state highly

depends on the quality of the initial guess, the initial Hessian and the search
direction. Search for transition states is sometimes described as an ‘art’. Experience
and practice are key, as well as maintaining a thorough understanding of the
available tools.

There are several alternative approaches to searching for a transition state with
Jaguar (Schrodinger's Quantum Mechanics Engine). For this lesson, we will be using
the AutoTS panel which is an automated workflow in which reactants and products
are input and interpolation is used to search for the transition state with minimal
user intervention. AutoTS is an automated way of finding transition states,
particularly for elementary reactions. Its workflow requires only the structures of
the reactants and the products as input, and then automates the rest of the
process: it optimizes reactants and products, determines which bonds are breaking
and forming, establishes correspondence between atoms in the reactants and the
products, generates a transition state guess (either from a template or using an
interpolated reaction path), launches a transition state search with the DFT engine
Jaguar, verifies if the located transition state is trustworthy, runs frequency
calculations, connects the transition state with the reactants and the products using
an intrinsic reaction coordinate (IRC) algorithm and finally prints the potential
energy surface diagram showing the transition state barrier. AutoTS works best on
reactions that have only one transition state between the reactants and the
products, such as the Diels-Alder reaction.

Computational Exercise #2: Generating a Transition State, Geometries of

Reactants and Products, and an Energy Diagram using AutoTS

Let's employ the AutoTS panel for the Diels-Alder reaction between butadiene and
ethylene. When an AutoTS job is submitted, it produces the following results:
1) Optimized geometries of the reactants and products
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2) A transition state structure with an animation to show bonds breaking and
forming
3) A potential energy surface diagram that includes a transition state barrier

(W AutoTS: Perform Calculations

Reaction Name: [Diels_Alder AutoTs |
Setup Reaction | Preview Reaction Complex | Advancedsettings ~ ON @ simple Diels-Alder reaction between

We will first perform an AutoTS calculation

LEdcants chloroethane and a bromide ion to learn

Sketch ori rt tant: Sketch I nt - .
e ey e the mechanics of the panel.

Figure 4-1. Opening the AutoTS panel.
& pening P 1. Go to Tasks and type AutoTsS. Click

AutoTS... Other Applications

© 2D sketcher =lolx|

e[ ] [ O0® @ (& 2 (under the AutoTS category)

o The AutoTS: Perform
‘ Calculations panel opens
com 2. Change the Reaction Name to
F oo si Diels_Alder_AutoTS

A‘&@, 7 .

He 5 4 /\” 3. Under Reactants, click Sketch and
_ory draw butadiene. In the 2D
SN\ .
000 Sketcher, select the carbon single
g‘Z bond, then click and drag to form a
Re Sy = C-C single bond, and continue
.hlgw : adding to get a 4-carbon chain.
add ydogens Under Molecular Properties, ensure

Figure 4-2. Sketching the butadiene reactant
in the AutoTS panel.

the Total Charge is 0, Spin
Multiplicity is 1, and the box to Add
Hydrogens is checked. It's okay if
butadiene appears to be s-trans in
the AutoTS panel - it will reorient to
s-cis during geometry optimization.
Click Save.

4. Under Reactants, click Sketch and
draw ethylene. In the 2D Sketcher,
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@ 2D Sketcher =loix|

."s.uE(r .} ROH VA 0 "T, ﬁ: L 2

Total Charge: o |2
Spin Multiplicity: |1
Vv|Add Hydrogens

Reset | save ] Cancel

Figure 4-3. Sketching the Cl~ reactant in the
AutoTS panel.

[ AutoTs: Perform Calculations M=)
Reaction Name: |Diels_Alder_AutoTS Duplicate | Export.. New Diels_Alder_AutoTS ~
Setup Reaction Preview Reaction Complex Advanced Settings

Reactants

Sketch or import new reactant: | Sketch Import -
1 2
70 70
\_\ ———
\ —
Products
Sketch or import new product: | Sketch | Import -
1
70

$

Figure 4-4. Sketching the products in the
AutoTS panel.
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select the carbon single bond, then
click and drag to form a C-C single
bond, and double-click to form a
double bond. Under Molecular
Properties, ensure the Total Charge
is 0, Spin Multiplicity is 1, and the
box to Add Hydrogens is checked.
Click Save.
Under Products, repeat the process
and draw the products of the
Diels-Alder reaction.

o Your inputs should match the

Figure 6-4.
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( AutoTs: Perform Calculations =10l x|

Reaction Name: [Diels_Alder_AutoTs

Setup Reaction | Preview Reaction Complex | Advanced Settings

Reaction Options

Duplicate | Export. New | Diels Alder AutoTs ~

Total Spin Multiplicity of Reaction: |1 Intrinsic Reaction Coordinate (IRC) |LQA

V] Optimize Input Molecules Jaguar Keywords:

¥/ Use Templates Special Options:

v/ Compute Energ

Level of Theon Path Options

I Method: [B3LYP-D3 Iﬂ IBasls set: [6-316+* ll

Distance Coordinates )@

No Solvation
Distances between geometries: (020 A [+

y Only ~)@
Root Mean Square Deviation: [0.25 A |2

Job name Imels alder AutoTS I Run
(¢4 @

Figure 4-5. Advanced settings and naming the
job.

L AutoTS: Perform Calculations - Job Settings x|
Output
Incorporate: | Append new entries as a new group v
Job

Job name: |Diels_alder AutoTS

Host: |cpu (1600) ~

Maximum # processors: | 2]
Limit number of simultaneous subjobs o

0K Cancel @

Figure 4-6. Adjusting job settings from the
gear icon and running the job.
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6. Go to the Advanced Settings tab
o We will keep the settings as
default in this case
o Level of theory:
i.  Method: B3LYP-D3
ii. Basis Set: 6-31G**
7. Change the Job
Diels_Alder_AutoTS

name to

£ -

8. Adjust the job settings (
needed

) as

o Change host from local host
to CPU host.
o Change the Maximum # of
Processors to 12. The job
can be completed in about 5
minutes on a 12 CPU host
9. If you would like to run the job
yourself, click Run. Otherwise, we
can import pre-generated outputs in
the analysis stages
10. Close the AutoTS panel

Note: The Preview Reaction Complex tab can
be used to generate reactant and product
complexes (merged structures) and to see
a guess at the reaction path. Adjustments
can be made as needed
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When the job is complete, we can view the
results in the AutoTS: View Results panel.
The AutoTS calculation assesses various
In Title paths without any additional user input

V¥ Diels Alder .| =

11. Go to File > Import Structures
reactant 12. Select the
transition_s.. i Diels_Alder_AutoTS_full_path.mae

product-molecul.. file and click Open
o If you did not perform the

Figure 4-7. Importing the results of the

AutoTS calculation. calculation yourself and wish

to open the pre-generated
results, select the
Diels_Alder_AutoTS_full_path.
mae file and click Open
o An entry group including the
reactant, transition state and
product structures is added
to the entry list
13.Use the Workflow Action Menu

(WAM) button (H) to access the
Results panel

Alternatively, go to Tasks and type AutoTS
Results and load the full_path.mae file via
the Import button

Figure 4-8. AutoTsS results.
The AutoTS: View Results panel contains

the energy diagram associated with the
reaction. If you are interested in viewing
the vibration associated with the transition
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state, use the vibration viewer (@) in the
entry list and animate in the workspace

Pause & Think #2. Using the AutoTS results, let's analyze the
Diels-Alder reaction further. Answer the following guestions:

a) Take screenshots of the optimized geometries for the reactants, transition state
structure, and products.

b) List the C-C bond distances of each molecule using the Measure button in units of

angstroms.
Reactants Transition State Structure Products
Screenshot: Screenshot: Screenshot:
Bond distances: Bond distances: Bond distances:
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¢) Now let's analyze the transition state structure. Look at the animation of its
vibration. What is the hybridization of the carbon atoms involved in the bond
breaking and forming at the transition state? How does this differ from the
reactants’ starting geometry?

d) Take a screenshot of the reaction energy diagram. Is the reaction exergonic or
endergonic? What is the activation energy barrier in units of kcal/mol? Would the
reaction speed up or slow down if the dienophile included an electron-withdrawing
group such as an aldehyde?
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5. Individual Exercise

Part A:
For the following Diels-Alder reaction:

” Heat )

1) Label which reactant is the diene and which is the dienophile. Then, predict the
product and draw the arrow-pushing mechanism.

2) Generate the HOMO and LUMO of the diene and dienophile. Take a screenshot and
paste it below.

HOMO of Diene LUMO of Dienophile
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Part B:
For the following Diels-Alder reaction:

FF
O e
FF

1) Label which reactant is the diene and which is the dienophile. Then, predict the
product and draw the arrow-pushing mechanism.

2) Look at the pre-generated AutoTS results for this reaction. Take screenshots of the
optimized geometries for the reactants, transition state structure, and products.

Reactants Transition State Structure Products

Screenshot: Screenshot: Screenshot:
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3) Take a screenshot of the reaction energy diagram. Is the reaction exergonic or
endergonic? What is the activation energy barrier in units of kcal/mol?

Part C:
Compare the two reactions from Part A and Part B. Which reaction do you expect to have a
faster reaction rate and why?

7. Summary, Additional Resources, and References

Using Maestro, students learned how to use Jaguar's AutoTS panel to perform geometry
optimization calculations of the reactants and products of a Diels-Alder reaction, determine
which bonds are breaking and forming, establish correspondence between atoms in the
reactants and the products, and generate a transition state structure.They learned how to
render a potential energy surface diagram to show the activation energy barrier. Lastly,
students generated molecular orbitals of the diene and dienophile to better understand
that constructive orbital overlap is necessary for new bond formation..
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For further learning:

For introductory content, focused on navigating the Schrédinger Materials Science
interface, an Introduction to Maestro for Materials Science tutorial is available.

For some related practice, proceed to explore other relevant tutorials:

e Introduction to Geometry Optimizations, Functionals, and Basis Sets

e Locating Transition States

For further reading:

e Intr ion m ional Chemistry, 3rd Edition
e FEssentials of Com ional Chemistry: Theori nd M Is, 2nd Edition

e See theJaguar help documentation

8. Glossary of Terms

Entry List - a simplified view of the Project Table that allows you to perform basic
operations such as selection and inclusion

Included - the entry is represented in the Workspace, the circle in the In column is blue

Project Table - displays the contents of a project and is also an interface for performing
operations on selected entries, viewing properties, and organizing structures and data

Recent actions - This is a list of your recent actions, which you can use to reopen a panel,
displayed below the Browse row. (Right-click to delete.)

Scratch Project - a temporary project in which work is not saved. Closing a scratch project
removes all current work and begins a new scratch project

Selected - (1) the atoms are chosen in the Workspace. These atoms are referred to as "the
selection" or "the atom selection". Workspace operations are performed on the selected
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atoms. (2) The entry is chosen in the Entry List (and Project Table) and the row for the entry
is highlighted. Project operations are performed on all selected entries

Working Directory - the location that files are saved

Workspace - the 3D display area in the center of the main window, where molecular
structures are displayed

2D Workspace - the 2D panel that opens from the “edit” dropdown that allows for the
construction of molecules using a 2D sketcher

Tile - if multiple entries are included, included entries are displayed side by side in
individual boxes rather than being overlaid in the same space
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